CENTURY 21
eMail@century21.com
User Guide

Publication Date: December 14, 2009
Table of Contents

1. Overview ............................................................................................................................... 1
   1.1. Document Conventions ......................................................................................................... 1
2. About Basic eMail@century21.com ....................................................................................... 1
   2.1. Account Creation .................................................................................................................. 1
   2.2. Where to Login to eMail@century21.com .............................................................................. 1
3. Mail ....................................................................................................................................... 2
   3.1. Read Mail .............................................................................................................................. 2
   3.1.1. Managing Your Inbox ............................................................................................................ 2
   3.1.2. Using the Preview Pane ........................................................................................................ 5
   3.1.3. Searching For Messages ...................................................................................................... 6
   3.1.4. Read Mail Features ............................................................................................................... 7
   3.2. Send Mail .............................................................................................................................. 7
   3.2.1. Sending Mail ......................................................................................................................... 7
   3.2.2. Access your Contacts ........................................................................................................... 8
   3.2.3. Spell Check ......................................................................................................................... 10
4. Calendar ............................................................................................................................. 10
   4.1. Using Your Calendar ........................................................................................................... 10
   4.1.1. Day/Week/Month/Year Views: ............................................................................................. 11
   4.1.2. Grid/List Modes: .................................................................................................................. 11
   4.1.3. Searching: ........................................................................................................................... 12
   4.1.4. Filtering: .............................................................................................................................. 12
   4.2. Creating and Editing Events ................................................................................................ 12
   4.2.1. How to Add an Event .......................................................................................................... 12
   4.2.2. How to Edit an Event ........................................................................................................... 13
   4.2.3. Event information ................................................................................................................ 13
   4.2.4. Toolbar Actions ................................................................................................................... 14
   4.3. Deleting Events ................................................................................................................... 15
   4.4. Working with other calendar services .................................................................................. 15
   4.4.1. Sending event invitations .................................................................................................... 15
   4.4.2. Receiving event invitations .................................................................................................. 15
   4.4.3. Free/busy information sharing ............................................................................................. 15
4.5. Import Events/Tasks from A File ......................................................................................... 16
4.6. Export Events/Tasks to A File ............................................................................................. 17
5. Contacts

5.1. Using Your Contacts

5.1.1. Overview

5.1.2. Searching

5.2. Creating and Editing Contacts

5.2.1. How to Add an Contact

5.2.2. How to Edit an Contact

5.2.3. Contact information

5.3. Creating Contact Group

5.3.1. How to Add an Contact Group

5.3.2. How to Edit an Contact Group

5.4. How to Import/Export Contacts

5.4.1. Import Contacts

5.4.2. Export Contacts

6. Tasks

6.1. Using Your Tasks

7. Notes

7.1. Viewing notes

7.2. Category Filter

7.3. Adding a Note

7.4. Deleting Notes

7.5. Printing Notes

8. Options

8.1. Settings

8.1.1. General

8.1.2. Read Mail

8.1.3. Write Mail

8.1.4. Calendar

8.2. Signatures

8.2.1. New Signature

8.2.2. Delete Signature

8.2.3. Set Default Signature

8.3. Change Password

8.4. Message Filters

8.4.1. Forwarding
8.4.2. Notification ................................................................. 45
8.4.3. White List ................................................................. 47
8.4.4. Junk Mail Filters ....................................................... 51
8.4.5. Additional Considerations ................................. 55
8.5. Vacation Reply ............................................................... 56
8.5.1. Overview ................................................................. 56
8.5.2. Create a Vacation Reply ........................................ 56
8.5.3. Edit or Delete a Vacation Reply ....................... 58
8.6. Message History ............................................................ 58
8.7. Restore Mail ............................................................... 60
8.8. Access History ............................................................... 61
9. Wireless Access ............................................................... 62
9.1. POP3 Settings ............................................................... 62
1. Overview

eMail@century21.com is the CENTURY21 web-based email system based on USA.NET’s Commercial Messaging Service (CMS) email system. It will allow you to check your email from any computer connected to the Internet so you can stay connected wherever you might be. eMail@century21.com offers you all the basic features that have become familiar to email as well as some unique features you might not find elsewhere. This document will help guide you through features that will help you get the most out of your email.

Before you go any farther in this document, you should understand the business rules of eMail@century21.com. The following are some basic functions and standards of eMail@century21.com which have been put in place so CENTURY21 can offer you the best email experience possible.

1.1. Document Conventions

- **User Input** is text the user must enter into the computer, usually into some data entry field in an on-screen form.
  - When the user input text is formatted as follows, **type the text in exactly as shown** inside the gray, outlined box.
  - When brackets `<>` surround the text, the brackets indicate that it is `<variable text, type in the text that is appropriate to you>`. **DO NOT** include (type in) the brackets.

2. About Basic eMail@century21.com

2.1. Account Creation

New eMail@century21.com accounts are automatically generated when someone is entered into CREST. Once their data is entered in CREST, their data is fed into the eMail@century21.com database and a new account is created.

The standard for creating an account is **first name.lastname@century21.com**.

**Example:** john.doe@century21.com

If there is already a person in the email database with the same name, a number will be placed after your username.

**Examples:** john.doe1@century21.com, john.doe2@century21.com, etc.

Your **password** is **initially setup** to be your **Company CREST ID number**.

2.2. Where to Login to eMail@century21.com

[http://mail.century21.com](http://mail.century21.com)
3. Mail

3.1. Read Mail

3.1.1. Managing Your Inbox

Your mail list page allows you to quickly manage mail in your folders. You can navigate around your mail list page using your mouse or your keyboard.

**Mouse Navigation:** You can use your mouse to select items, take actions using the toolbar, or take actions using the right-click menu.

**Keyboard Navigation:** You can use your keyboard to move around your list of items (up and down arrows), open an item using the "enter" key, or delete an item using the "delete" key.

**Toolbar**

The following actions are available through the toolbar:

**New Menu**

- Click on the Mail button to create a new mail message
- Click on the Contact button to create a new contact
- Click on the Event button to create a new calendar event
- Click on the Task button to create a new task
- Click on the Note button to create a new note

**Reply to Message:** Click on the Reply button to send a response to the sender of the message.

**Reply to All Message:** Click on the Reply All button to send a response to the sender and all recipients of the message.

**Forward Message:** Mouse over the Forward button. You can then select the Forward Inline or Forward as Attachment item. If you have multiple messages selected, you can only forward as attachments.

**Delete:** Click on the Delete button ( ) to delete any mail messages you currently have selected.
**Move Message to Folder**

Mouse over the **Move** button. You can then select a folder where you want to move selected messages to.

**Submit Spam:** Click on the Spam button to report spam messages that our filters did not catch.

**Open Template:** From the Draft folder, click on the **Open Template** button to open a draft message without making changes to it. This feature allows you to create a draft message that you want to use multiple times without it being deleted when you send the message. **Note:** This will only appear if you are in your draft folder.

**Refresh:** Click on the Refresh button to refresh your list of messages.

**Print Message:** Click on the Print button to print the currently selected message. You can only print one message at a time.

**More Button**

**Mark as Read or Unread:** Mouse over the **More** button. You can then select the Mark as Unread or Mark as Read items.

**Flag Message:** Mouse over the **More** button. You can then select the Flag Message or Clear Flag items.
Show Preview Pane: Click on the Hide Preview Pane button to enable the preview pane.

Hide Preview Pane: Click on the Show Preview Pane button to hide the preview pane.

Advanced Search: Click on the Advanced Search button to search for messages in your folders.
Current Folder Search: Type a search string in the search text box and click on the to search for messages in your current folder.

3.1.2. Using the Preview Pane

In the Preview Pane you can preview an item without opening it. To display an item in the Preview Pane, single click it. You can read the content of a message, open attachments, follow a hyperlink and respond to meeting or task requests.

3.1.2.1. Turning the Preview Pane on and off

The Preview Pane can be turned on and off from the Options and Settings page. Select the Options icon then select Settings from the left hand menu. The Read Mail tab in the main window contains a Preview Messages section.

Check the "Enable preview pane" check box to turn the Preview Pane on, uncheck it to turn it off. Click the Save icon in the upper left hand corner to save the setting.

You can automatically preview the first message in a list or wait until you select a message for preview. To do it automatically check the "Automatically preview first message in list" check box and to wait until you select a message uncheck it. Click the Save icon in the upper left hand corner to save the setting.
When using the preview pane, there are three options for when a message gets marked as read: *Never*, *After previewing for ## seconds* and *Immediately after moving to another message*

- **Never** - The previewed message is not automatically marked as read
- **After previewing for ## seconds** - The previewed message is marked as read after it is displayed in the preview pane for the selected number of seconds (0, 5, 10, 15, 30, 45, 60)
- **Immediately after moving to another message** - The previewed message is marked as read after selecting another message to be displayed in the preview pane

After selecting the setting that you want, click the Save icon in the upper left hand corner to save it.

### 3.1.2.2. Resizing Preview Pane

![Resizing Preview Pane](image)

### 3.1.3. Searching For Messages

Use different criteria to search your folders for a specified message.

To search for a specific message from the Read Mail page, please follow these steps:

1. Click Read Mail on the Navigation Bar on the left side of your Web browser window
2. Click Search Mail in the upper or bottom right hand corner of the page, or click Search Mail under Read Mail on the Navigation Bar.
3. Enter the search criteria into the appropriate search field(s): To, From, Subject, Priority, Status, and/or Received. Checking the Case Sensitive Search box will further refine the search.
4. Select the folder(s) to search. If you want to search all folders, check Select All Folders. Note: You must select at least one folder to perform your search.
5. Click Search. An index of the messages matching the criteria you entered will be displayed. To read a message, click the sender's name listed in the From column.

**Note**: Search entries are considered phrases. Entering multiple words in a single category will provide a list of results where those words are used as a phrase.
3.1.4. Read Mail Features

[Coming Soon]

3.2. Send Mail

3.2.1. Sending Mail

Use the New Message window to send messages to co-workers, family, and friends. You can also create draft messages that you can send later.

In order to send mail, choose the button on the mail list page.

Toolbar: The following actions are available through the toolbar:

Send Message: Click the Send button to send the message you have composed.

Save Draft: Click the Save Draft button to save a copy of the message you have composed to your Draft folder. If you want to have draft automatically be saved while you are composing, you can choose the "Periodically auto-save a temporary copy of email in your Draft folder" option on the "Write Mail" section of the Settings page. To access your settings, click on the Options icon.
**Preview Message:** Click the **Preview** button to preview your outgoing message. This will allow you to see how your message will look if you are including a stationery.

**Spell Check:** Click the **Spell Check** button to check the spelling or your composed message. If you want to automatically check spelling whenever you send a message, you can choose the "Automatically Spell Check all messages" option on the "Write Mail" section of the Settings page. To access your settings, click on the Options icon.

![Spell Check Window](image)

**Insert Signature:** Click the **Signature** button to insert a signature in your message. A popup window will be displayed that will show all of the signatures that you have created in your account. If you want to create a new signature or designate one of your signatures to appear on all your new outbound messages, you can access the Signatures page by choosing Options icon and selecting Signatures on the left-hand navigation bar.

![Insert Signature Window](image)

**Add Attachment:** Click the **Attach** button to add an attachment to your message. A popup window will be displayed that will allow you to select a file to attachment. You can attach multiple files to your message. If you have issues attaching files, you can click on the "Attachments issues?" link. This will allow you to change your attachment method. If you do this, you will need to scroll down to the bottom of the Send Mail page to attach files.

**Close Window:** Click the Cancel button if you want to close the New Message window without sending your message.

### 3.2.2. Access your Contacts

When composing an email message, you can easily add recipients to your message by picking them from your Contacts list and the %Customer% Contact list. You can also choose addresses from the LDAP Directory.
To search these addresses from the New Message window, please follow these steps:

1) Click the To, Cc, or Bcc button

2) Choose the address book you wish to search from the drop-down menu

3) Enter a search string. This search string will be compared against the beginning of the first name, last name, and email address of individuals, and against the name of groups, to find matches. The search string is case-insensitive, and wildcards (*) are supported, but not required.

4) Example: entering "jo" in the search field would find all entries that have a first name beginning in "jo" (e.g., "John"), a last name beginning in "jo" (e.g., "Jones"), an email address beginning in "jo" (e.g., "jobs@..."), or a group name beginning in "jo" (e.g., "Joke Lovers")

5) Click Search to display the search results.

6) Select the appropriate addresses from the list displayed, then click the To, CC, or BCC options to address your message.
7) Continue searching your address book until all addressing is done. When you are done addressing your message, click Close to exit the results window.

3.2.3. Spell Check

When composing a message, check for spelling errors before it is sent.

To use Check Spelling from the Mullen Classic Autos site, please follow these steps:

1) After composing a message, click Check Spelling located at the top or bottom of the screen. All detected spelling errors will be enclosed in a box with a (?) next to each misspelled word.

2) Click the (?) for suggestions on the correct spelling of the misspelled word.

3) Once you find the correct spelling, highlight the correct word by clicking on the word. If there are no suggestions, a box will appear without a (?)

4) Click Ok. This will correct the misspelled word. If you do not see the spelling you are looking for, click Cancel and correct the word within the box itself by simply clicking in the appropriate field.

5) Continue this process until you have reviewed and corrected all of the misspelled words.

6) Click Ok. This will take you back to your document with the selected corrections applied.

Important: Check Spelling works in the default language of your mail session. However, for languages that use characters other than the Roman alphabet, only those words displayed in the Roman alphabet will be checked. All other characters will be ignored.

4. Calendar

Note: The Calendar and Task features require an upgrade to a 250MB or larger account.

4.1. Using Your Calendar

Use your calendar to store important events, meetings, appointments, holidays, birthdays, anniversaries, or any other important dates and times. Your calendar allows you to easily add, edit, and delete calendar events, view your calendar in various forms including day, week, month, and year views, and print your calendar.

When you select the Calendar link from the left-hand navigation bar, your calendar will be displayed using your default calendar view, and using today's date as the currently selected date. Your default calendar view, and other calendar related settings, can be configured in the Options page under the Calendar tab. You can use the mini-calendar at the top of the left navigation bar to select different dates for viewing.
4.1.1. Day/Week/Month/Year Views:
The calendar can be displayed using different views, including Day, Week, Month, and Year. Buttons to choose between the different views are in the toolbar at the top of the Calendar page.

- **Today** - Displays a Day view for today's date

- **Day View** - Displays a Day view of the currently selected date. A calendar containing your normal working hours will be displayed (working hours can be changed on the Preferences -> Settings page), with events shown in the calendar occupying the space corresponding to time of the event. Events that occur outside normal working hours will be displayed at the top of the calendar. The Subject and Location of the event will be displayed, along with small icons that identify if the meeting is a recurring meeting, if it has attendees, if it is high priority, and if a reminder is set for the event. Clicking on the Subject will edit the event and clicking on the 'X' will delete the event from your calendar. Double-clicking on any open time in the calendar will open a new window to create an event scheduled for that time.

- **Week View** - Displays a Week view containing the currently selected date. A calendar containing your normal working hours for each day of your week will be displayed (working hours and week start day can be changed on the Preferences -> Settings page), with events shown in the calendar occupying the space corresponding to time of the event. Events that occur outside normal working hours will be displayed at the top of the calendar for the day on which they occur. A partial Subject of the event will be displayed. Clicking on the Subject will edit the event and clicking on the 'X' will delete the event from your calendar. Double-clicking on any open time in the calendar will open a new window to create an event scheduled for that time.

- **Month View** - Displays a Month view containing the currently selected date. A month calendar will be displayed with events shown in the calendar occupying the space corresponding to day of the event. A partial Subject of the event will be displayed. Clicking on the Subject will edit the event.

- **Year View** - Displays a Year view containing the currently selected date. A year calendar will be displayed with dots indicating event on days. To view information on an event or edit an event, select the day, month, or year containing the event to go to the day, week, or month view. Editing events is not possible directly from the year view.

In all of these views, the Calendar page will display the date or dates being viewed above the calendar. There will be left and right arrows on either sides of the dates above the calendar allowing you to easily move ahead or back one day/week/month/year.

4.1.2. Grid/List Modes:
When viewing your calendar in the different views (Day, Week, Month, and Year), you will see different amounts of detail about the events in your calendar. The Day view shows the most details and the Year view shows the least details. Your calendar can also be viewed in either Grid mode, with a graphical layout of your calendar information, or List mode, where your calendar events are provided in a plain list format. When in List mode, you can switch to Grid mode by pressing the Grid Mode button ( ). When in Grid mode, you can switch to List mode by pressing the List Mode button ( ). When in either the Grid mode or the List mode, the data that you will be viewing
will be dependent upon the view you have chosen (day, week, month, year). The Grid mode for each view is described below:

When in List mode, you will also have buttons to Print and Delete selected events.

4.1.3. Searching:

You can search your calendar by entering a string in the Search field and pressing Enter or clicking on the Search button ( ). Any event in the current year with the search string found in the Subject or Description will be displayed, using the List mode. Clearing the Search field and pressing Enter or [Search] will clear the search and return all events. Searches always return results in List mode. Note: you may need to change your view (Day, Week, Month, or Year) to see events found in a Search. You may move a search to previous or future years using the Go To function or using the arrows to move forward or backward.

4.1.4. Filtering:

If you have specified categories for events, you can filter based on these categories by selecting a category from the Filter pulldown in the left-hand navigation bar. Only events that match the selected category will appear in your calendar. Note: you may need to change your view (Day, Week, Month, or Year) to see events matched by filtering.

4.2. Creating and Editing Events

4.2.1. How to Add an Event

A new calendar event can be created in any of the following ways:

- On the Calendar page, press the New button ( ), or by selecting the Event link ( ) in the New dropdown menu on any other main page.

- On the Calendar page in the Day or Week view (in grid mode), double click your mouse on any open timeslot.

A window will open allowing you to specify event information.
4.2.2. How to Edit an Event

To edit an event, find it on your calendar either by looking through your calendar or by using the Search (🔍) feature inside the calendar to search for words in the Subject or Description. Once you find the event, click on the Subject of the event to open the event. A window will open allowing you to modify event information.

4.2.3. Event information

When creating a new event or editing an existing event, you can specify the following information for your event:

- **Subject**: The subject of the event will be the title as it appears on the calendar and the title of the invite email that is sent to the attendees.
- **Location**: Specify the location of the meeting here.
- **Start and End Time**: Use this to set the start time of the event and the end time of the event.
- **All Day checkbox**: If the event lasts all day then simply check this box and it will be scheduled as an all day event.
- **Recurring**: If you want to schedule an events to occur at regular intervals select the recurring box. This will allow you to choose between various interval options such as daily, weekly, monthly, and yearly over a selected period of time.
- **Reminder**: If you want a window reminder to pop-up at a selected time before the meeting or event then select this box and amount of time before the event you would like the reminder to occur. You must have reminders enabled in your Preferences for this to work. This option can be found at Preferences --> Settings under the calendar section.
- **Show Time as busy/free**: This will determine whether or not the event will mark you as free or busy during the event time. If you give people the ability to view your free and busy time they can check your available times before sending you invites. The ability to allow people to view your free and busy times can be found in Preferences --> Settings under the calendar section.
- **Category**: You can assign a category to an event to help manage your events. Calendar filters can be used to view events by category.
• **Description**: If you would like to add additional comments about the meeting or event, place them here. These comments will be sent to the attendees.

### 4.2.4. Toolbar Actions

The toolbar at the top of the New Event page allows you to perform the following actions:

![Toolbar Actions](image)

- **Save** - Save - Saves the event to your calendar. If you are creating a new event and you added attendees, an email will be sent to all the attendees with information on the event. If you are editing an existing event, using this button to save the event will not send an update to the attendees.

- **[Save and Send Update]** - Save and Send Update - Saves the event to your calendar and sends updates to attendees. This option is only available if you are editing an event with attendees.

- **Invite Attendees** - This option enables an attendee list for the event, adding a required, optional, and resource line to the event window. You may either type in the email addresses of the desired attendees and resources or you may select one of options to pop-up a search window. In the search window you can enter in the search criteria then click the search button. A list of the search results will appear in the box. Select the person(s) or resource(s) you were looking for then add them to the required, optional, or resource list of your event by selecting the appropriate button. Email invitations are sent in iCal format, allowing most calendaring software to automatically recognize the invitation and send responses. To remove attendees for an event, press the No Attendees button ( ![Attendees](image) ).

- **Availability** - Availability - This option will pop-up a window that allows you to see your availability and the availability of the attendees and resources you have selected for your event. If there is no information available for an attendee or resource then that person or resource might not have their calendar set for others to view.

- **Delete** - Delete - Delete the event. This option is only available when editing an existing event. Deleting an event with attendees will ask if you want to send a cancellation notice to attendees.

- **Add Attachment** - You may add attachments to your events. These attachments will be available when viewing the event, and will be sent to attendees with the meeting invitation.

- **Close** - Close - This will close the new event window without saving it to your calendar. All options selected are discarded.
4.3. Deleting Events

To delete an event, first you must find it on your calendar. You can change the view to weekly, monthly, or yearly to assist you with this, or use the Search ( ) feature inside the calendar to search for words in the Subject or Description. Once the event has been located, perform the following action depending upon the calendar display mode:

- **Grid mode** - this is a graphical style calendar showing a layout of hours, days, and weeks, depending upon the view (day, week, month, or year). In grid mode, click on the boxed "x" located in the upper right hand corner of the event.

- **List mode** - this is a simple list of your events, with checkboxes on the left side of the list. Select the items you want to delete in the list, then press the Delete button ( ) in the toolbar. You can select multiple events for deletion at one time, but only if the events are not recurring and do not have attendees. Recurring events or events with attendees must be delete one at a time.

A pop-up window will appear to confirm the deletion. If it is a recurring event, you have the option of deleting just the selected occurrence or the whole series. If the event had attendees, you will be asked if you want to send a cancellation notice to the attendees.

When editing an event, you can also use the Delete button ( ) in the Edit Event page to delete the event.

4.4. Working with other calendar services

Your calendar can function with other calendar services in the following ways:

4.4.1. Sending event invitations

You can use your calendar to create events with attendees on other calendar services or clients. When event invitations are sent to the attendees, they are sent in the standard iCal format, which most calendar services can accept and display properly. Any Accept, Tentative, or Decline responses from attendees on iCal compliant services will show up in your mailbox and will automatically update your event so you can check attendee status for your event. For attendees that do not accept iCal format, invitations are also sent in a readadble format, but Accept, Tentative, or Decline responses will not be handled automatically.

4.4.2. Receiving event invitations

You will receive any email-based event invitations from other calendar services or clients in your mailbox. When you open any invitation in iCal format, you will be prompted to respond with Accept, Tentative, or Decline. If you respond with Accept or Tentative, the event will be automatically added your calendar. You will then be prompted on whether a response should be sent to the event originator. This response will be sent in iCal format so the originator's calendar can be automatically updated with your status. Any event invitations you receive that are not in iCal format will display as normal email messages and you will need to manually enter the event into your calendar.

4.4.3. Free/busy information sharing

You can make your free/busy data available to other calendar services or clients that support free/busy lookups using the iCal format with a free/busy URL. On the [Options] Options -> Settings page, in the Calendar tab, check the option to "Allow anyone on Internet to view my free-busy time".
You will need to provide your free/busy URL to people that want to access your free/busy time. Click the "What's this?" link to find your free/busy URL.

Although you can make your free/busy data available to other calendar services, you cannot currently access free/busy data from other calendar services inside your calendar.

4.5. Import Events/Tasks from A File

On the Options ➔ Settings page, in the Calendar tab, there is a button to import calendar events into your calendar. Clicking this button will open a page where you can select the file to import and the category to import the new events under.

![Import/Export](import_export.png)

**Note:** The file imported must be an iCal compliant file. Typically, iCal compliant files have a .ics file extension.

- **Category:** If a category is selected or entered in this field, the new imported events will all be placed into that single category. Any categories on the imported events will be replaced by the selected or entered category. If you wish to import the events without changing their categories, just select the empty category.
  - This can aid in sorting events when importing other calendars. Each imported calendar can be placed into its own category and then later select the option to filter on the calendar view to only show events in that category.
- **Calendar File to import:** Enter the file to upload from your computer or click the browse button to open a file browser and select the file you wish to import.
- **Import:** The import button begins the import process for the file selected.
- **Cancel:** The cancel button cancels and closes the window.

Exporting calendar information from Microsoft Outlook: Microsoft Outlook does not provide a built in mechanism to export its calendar information to the iCal format. There are very few third party tools to facilitate this export.

- Exporting from OS X iCal/Entourage: We support files that are exported on the Mac directly from iCal. To do this, open the iCal program, select the calendar you wish to export in the Calendars window, select the menu File ➔ Export and enter the file to export. On our site, select the Import button and that file you just saved.
  - To export Entourage calendar data, we recommend using iCal to import the data and then exporting that calendar to an .ics file that can be imported. To do this, open iCal select the
menu **File ➔ Import**, in the pop-up window select Entourage. Once the Entourage import is complete, select the menu **File ➔ Export**, enter the file to save the data to and then import that file with our import page.

**4.6. Export Events/Tasks to A File**

On the **Options ➔ Settings** page, in the Calendar tab, there is a button to export calendar events and tasks to a file on your local computer.

Clicking this button will open a page where you can select whether to export tasks, calendar events or both. There are options to only export events/task that match the selected categories, or that occur between a set of start and end dates.

- **Export Tasks Only**: Select this to only export tasks.
- **Export Calendar Only**: Select this to only export calendar events.
- **Export both Calendar and Tasks**: Select this to export both calendar events and tasks.
- **Export events/tasks that belong only to the selected categories**: This will restrict the exported events/tasks that only have the selected categories. To export all events/tasks, select the 'All' category.
- **Export events/tasks that occur between this start and end date**: Select a start and end date that exported events/tasks must fall between. Dates should be in mm/dd/yyyy format. To select a date, click on the calendar icon next to the text box, the date will be placed in the box.
  - **Note**: If there is a Start Date but no End Date, the events/tasks starting with the Start Date and ending with the last day of the year given in the Start Date will be exported. If there is an End Date but no Start Date, the start date is assumed to be the date the export is started.
- **Export**: The Export button will begin the exporting process. A window will prompt you for the file name to save the export.
- **Cancel**: The Cancel button will cancel the export.
5. Contacts

5.1. Using Your Contacts

5.1.1. Overview

Use your contacts to store information about your business associates, friends and family members. Your contacts allows you to easily add, edit, and delete contact information, create contact groups, quickly search for information, and print your contacts.

When you select the Contacts link from the left-hand navigation bar, your contacts will be displayed. By default, all of your contacts and groups will be displayed. You can filter your contacts by choosing the 'Contacts and Groups', 'Contacts Only', or 'Groups Only' radio buttons on the left-hand navigation bar.

5.1.2. Searching

You can search your contacts by entering a string in the Search field and pressing Enter or . Any contact or group with the search string found in the Name or Email Address will be displayed. Clearing the Search field and pressing Enter or will clear the search and return all contacts.

5.2. Creating and Editing Contacts

5.2.1. How to Add an Contact

A new contact can be created in any of the following ways:

- On the Contacts page, press the New button ()
- Or by selecting the Contact link ( ) in the New dropdown menu on any other main page

A New Contact window will open allowing you to specify contact information on 5 different tabs
5.2.2. How to Edit an Contact

To edit a contact, find it on your contact list either by looking through your calendar or by using the Search feature inside the contact list to search for words in the Name or Email Address. Once you find the contact, double-click the row to open the contact. You can also click with your right mouse button on the row and open the contact through the popup menu.

An Edit Contact window will open allowing you to modify contact information.
5.2.3. Contact information

When creating a new contact or editing an existing contact, you can specify various information for your contact, including name, email addresses, phone numbers. There are 5 different tabs for the various types of contact information.

![New Contact Page Screenshot]

The toolbar at the top of the New Contact page allows you to perform the following actions:

- ![Save Button] - Saves the contact to your contacts
- ![Save and Add Next Button] - Saves the contact to your contacts and allows you add another contact
- ![Delete Button] - Delete the contact. This option is only available when editing an existing contact
- ![Close Button] - This will close the new contact window without saving it. All information added will be discarded

5.3. Creating Contact Group

5.3.1. How to Add an Contact Group

On the Contacts page, press the New Group button ( ). A window will open allowing you to specify contact information.

![Contacts Page Screenshot]

**Name:** Enter the name of the group you want to use. You can enter this name when you are sending mail

**Notes:** Enter a description of the group in this field
Personal Members Tab: Choose this tab which will allow you to select members from your contacts list to add to the group.

Company Members Tab: Choose this tab which will allow you to select members from your Company’s Contacts list to add to the group.

Click on the Add Button to search through the Company Contact List.
5.3.2. How to Edit a Contact Group

To edit a Contact Group, find it on your contact list either by looking through your contacts or by using the Search ( ) feature inside the contact list to search for words in the Name or Email Address. Once you find the contact, double click row to open the contact. You can also click with your right mouse button on the row and open the contact through the popup menu.

The toolbar at the top of the Edit Group pop-up allows you to perform the following actions:

- [ ] Save - Saves the contact group to your contacts
- [ ] Delete - Delete the contact group. This option is only available when editing an existing contact group
- [ ] Close - This will close the new group window without saving it. All information added will be discarded

5.4. How to Import/Export Contacts

5.4.1. Import Contacts

To import contacts, click on the Contacts link ( ) on the left-hand navigation bar to access your Contacts.

Then click on the Import Button ( ) on the Contacts page toolbar.
File Format: Choose from either CSV (Microsoft Outlook) or LDIF (Netscape Messenger)

Character Encoding: Choose from either Western European or Unicode (UTF-8)

Contact file to import: Enter the file to upload from your computer or click the browse button to open a file browser and select the file you wish to import

Import: The import button begins the import process for the file selected

Cancel: The cancel button cancels and closes the window

Note: When importing an address book from another mail client, some information, such as group names and/or lists, nicknames, or physical addresses may not be imported. We recommend verifying all the information in your imported Contacts before use.

5.4.2. Export Contacts

To export contacts, click on the Contacts link ( ) on the left-hand navigation bar to access your Contacts

Then click on the Export Button ( ) on the Contacts page toolbar.

File format: Choose from either CSV (Microsoft Outlook) or LDIF (Netscape Messenger)
6. Tasks

**Note:** The Calendar and Task features require an upgrade to a 250MB or larger account.

6.1. Using Your Tasks

The left hand toolbar provides a link to the Tasks page. The Tasks page will list all tasks by subject, their status, due date, percentage complete, and whether they have been assigned to another or group.

**Viewing tasks:** The main tasks page allows you to view tasks, including their Subject, Start and Due dates, status, type, priority, and percent complete. All tasks can be viewed at once, or tasks can be viewed in groups of Current tasks, Future Tasks, and Completed (Done) tasks. Switching between these views can be performed easily using the radio buttons left-hand menu:

Current tasks are non-completed tasks with no start or due dates, or tasks with start or due dates within the next **14 DAYS**. Future tasks are non-completed tasks with start dates more than 14 days in the future, or tasks without start dates and with due dates more than 14 days in the future.

**Category Filter:** If you have any tasks assigned to Categories, a drop down menu will display on the left hand menu and allow you to filter the viewed Tasks by category. Selecting a particular category will change the view to show only tasks that belong to that category. To view all tasks, select the 'None' option to turn the filtering off.
Adding a Task: You can add a task by selecting the New Task icon ( ). Clicking on this icon, will open the add task window.

To add a task, type a subject in the 'Subject:' text box and click the Save icon ( ) in the upper left hand corner.

You can also add other optional information by selecting a start date, due date, status, % complete, classification, priority, category or add a reminder.

You may also assign this task to another by clicking the Assign Icon ( ) which will open an 'Assigned To:' text box in which to type the email address of the person or persons to assign the task to. Clicking the 'Assigned To:' link will open an addressbook to allow you to look up email addresses. Once you find the email address in the addressbook, select it, click the assigned to button, and the close button. The selected email will show up in the Assigned To: text box.
You can select multiple email addresses in the addressbook window and assign each of them. All assigned email addresses will be placed in the text box.

If you want to attach files to your notes, click on the add attachment icon (_attach). You can then select the file you want to attach from the file browser.

**Deleting Tasks:** You can delete tasks by selecting the checkboxes in the first column of the task list and clicking on the delete icon (_delete).

If you want to delete all of your tasks, you can select "X" in the task header. After you click the delete icon, You will be prompted before the delete action is finalized. If you delete multiple tasks and some of the tasks require updates to the owner or assignees, no updates will be sent. If you want to send updates, you should delete those tasks one at a time.

**Reading a Task Entry:** The first icon shows whether the task is a personal task, assigned to another person or assigned to a group of people. These are distinguished by three icons:

- A personal task:
- An assigned task:
- A group assigned task:
- A task assigned to you :
- A task declined by assignee:

The next column will contain an exclamation point '!' in red if the task is high priority.

The next column will display the percentage complete for the task, if any. To update the percentage complete, click the task subject link and enter the percentage in the % Complete box and save the changes.

The next column will show the current status of the task. A task can have one of three status': Not Started, In Progress, and Completed. You change the status and percent complete of a task by left-clicking on the status box and selecting the new status or percent complete. The three status' are represented by the following icons:

In addition to the icon changing when a task is Completed, the subject will also be changed to be strike through font.

The Subject column displays the subject for a task. Double clicking anywhere on the row of a task will open an edit window similar to the Add Task window which will allow you to update information about the task. To sort tasks by Subject, simply click the Subject column header. The red arrow icon (_sort) will show how the tasks are currently sorted. Default is to sort by Due Date.

If the task has a start date, it will be displayed in the next column. Otherwise, this column will be blank. You may sort your task list by start date by clicking the 'Start Date' column header.

If the task has a due date, it will be displayed in the last column. Otherwise, this column will be blank. You may sort your task list by due date by clicking the 'Due Date' column header.
Printing Tasks: To print a task list, click the print icon (Print). An Operating System (OS) printing tool will be started that will allow you print the task list.

7. Notes

The left hand toolbar provides a link to the Notes page. The Notes page will list all notes by subject and any associated date.

7.1. Viewing notes

The main notes page allows you to view notes, including their Subject and Date.

7.2. Category Filter

If you have any notes assigned to Categories, this drop down menu will display on the left hand menu and allow you to filter the viewed Notes by category. Selecting a particular category will change the view to show only notes that belong to that category. To view all notes, select the 'None' option to turn the filtering off.
7.3. **Adding a Note**

You can add a note by selecting the notepad icon ( ).

Clicking on this icon, will open the add note window. To add a note, type a subject in the 'Subject:' text box and click the Save icon ( ) in the upper left hand corner.

You can also add other optional information by selecting a date, and category, and you can enter detailed information in the text field at the bottom.

7.4. **Deleting Notes**

You can delete notes by selecting the checkboxes in the first column of the notes list and clicking on the Delete icon ( ).

If you want to attach files to your notes, click on the add attachment icon ( ). You can then select the file you want to attach from the file browser.

If you want to delete all of your notes, you can select "X" in the note header to select all notes. Then click on the Delete icon ( ). You will be prompted before the delete action is finalized. Clicking on the "X" in the note header again will deselect all of the notes.

7.5. **Printing Notes**

To print a note list, click the Print icon ( ). An OS printing tool will be started that will allow you to print the note list.
8. Options

The left hand toolbar provides a link to the Options page.

8.1. Settings

Then select 'Settings' from the left-hand navigation bar and choose the General tab.
8.1.1. General

Your General settings control features that are available throughout the Webmail client. The settings are grouped in the following sections:

8.1.1.1. Page View

Control general settings for how you will view pages of information in the webmail client.

After login, start at: Home Page or Mailbox

Choose the page which will be displayed after you login to the webmail client. Either go directly to your Mailbox (Inbox) or go to the Home Page. The Home Page is also accessible at any time by clicking on the Home link (Home) in the upper right header bar.

When showing list of items, show 10-100 items per page

Select the number of items you want to display per page from the drop-down menu. The number selected will determine the number of items that display in Read Mail, History, and many other pages.

8.1.1.2. Dates and Times

Control the format for dates and times used throughout the webmail client

Date format: MM/DD/YY, DD/MM/YY, YY-MM-DD

Choose from among different style for representing dates. YY = year, MM = month, DD = day

Time format: 24 Hour or 12 Hour

Choose from either 12 hour (with a.m. and p.m.) or 24 hour times.
**Time zone**: Choose the preferred time zone for your Mullen Classic Autos account by selecting from the drop-down menu.

Note: The time zone selection is reflected on all incoming and outgoing messages, and other places in the site where times are used. Daylight Savings Time is applied where necessary, based on the time zone selection.

### 8.1.1.3. Mailbox Cleanup

Control how your Trash and Junk Mail folders are cleaned up

**Automatically delete mail in my Junk Mail folder after 3, 7, OR 14 DAYS**

Select the number of days that you want to keep mail in the Junk Mail folder. Mail that has been in the Junk Mail folder for more than this number of days will be automatically deleted.

**Empty Trash on Logout**: Check this box to automatically clear the contents of the Trash folder every time you logout.

**Do not show warnings when emptying Trash or Junk Mail from Menu Bar**: Check this box to suppress popup confirmation prompts when using the [Empty] links next to the Junk Mail and Trash folders on the left hand Navigation Bar.

### 8.1.1.4. Security and Privacy

Control settings related to security and privacy in your account

**Do not save message history**: Check this box to delete all current message history entries and to prevent further saving of message history

**Note**: If you re-enable Message History, only messages received after you reactive will have history saved

**Do not allow messages to be restored after emptying Trash**: Check this box to delete all current restorable messages and to prevent further saving of deleted messages

**Note**: If you re-enable Message Restore, you will only be able to restore messages that are deleted after this time.
8.1.2. Read Mail

8.1.2.1. Message Viewing

Control settings for how content inside messages is viewed.

View attached images inside messages

Check this box if you want images received as attachments to be automatically opened at the bottom of your message.

Note: This option allows particular file types such as .gif, jpeg, or HTML to automatically open. File attachments that require another application be used for viewing will not open within your message.

Hide images from the Internet in HTML messages

Check this box if you want to hide all images from the Internet when reading HTML messages. If selected, images from the Internet will be replaced with a gray box when viewing the message. You will be notified of this change on the Read Mail page and you may select an option to view the images. Any classified as spam or in your Junk Mail folder will automatically have this option applied, regardless of whether you have selected this option or not.

Note: This option does not apply to attachments (see "View attached images inside messages" above) or to certain types of embedded images such as stationery.

View messages using a fixed-width font
Check this box if you want all plain text messages to be displayed with equal space between each character.

### 8.1.2.2. Message Notification and Searching

Control settings for new message notification and email searching.

Notify when new messages are received while logged in

Check this box to receive notification via a popup window when new messages are received while you are logged into the webmail client. There may be a delay between the time a message is received and the time the notification is displayed since the system will only periodically poll your Inbox for new messages. You will only be notified of new mail in your Inbox and not in other folders.

Note: This feature may not work on all browsers. If you are using a popup blocker, this feature may not work unless you allow popups from this site. This feature requires a constant connection to the Internet; if your Internet connection is lost, your browser may attempt to reconnect to the Internet.

Enable advanced searching

Check this box to enable searching the body of emails when using the advanced email search. The advanced search feature is available when viewing a list of mail messages. Without this option selected, you will only be able to search for words in the Subject and From/To of emails. With this option selected, you will also be able to search for text in the body of emails.

### 8.1.2.3. Preview Messages

Control settings for how messages are previewed when the Preview pane is enabled. The Preview pane is can be turned on or off and is displayed below the list of email messages, allowing a small area to view the content of a selected message.

Enable preview pane

Check this box to show the preview pane under the list of messages. You can also turn on the preview pane by clicking on the button, or turn off the preview pane by clicking on the button on the toolbar when viewing your list of messages.

Automatically preview first message in list

Check this box to automatically select the first message in the list of messages when you view the contents of a mail folder. This option will not have any effect in the Junk Mail folder in order to protect you from automatically viewing known spam.

When previewing messages, mark messages as read:

If you are using the preview pane to view messages, use this option to choose when messages should be marked as "read". Choose from one of three options:

Never - Do not mark messages as read after previewing. Messages will only be marked as read if you select the Mark as Read option or if you Open (double-click) a message.

After previewing for ____ seconds - Specify the number of seconds for which you want to preview messages before they should be marked as read. If you preview an item for less that this time, the message will not be marked as read.

Immediately after moving to another message - When you select another message, the previous message being previewed will be marked as read.

If a message contains a request for a Read-Receipt, you will be prompted to send the Read-Receipt only when the message is marked as read.
8.1.2.4. **Message Navigation**

After moving/deleting a message:

When you have selected and/or are viewing a message, specify what to do after deleting the message or moving the message to another folder.

- Select the next message - Automatically move to the next message in the list
- Select the previous message - Automatically move to the previous message in the list
- Do not automatically select another message - If you are using the preview pane, do not automatically select any message. If you double-clicked the message or used Open to view the message in a popup window, close the window after deleting or moving the message.

8.1.3. **Write Mail**

8.1.3.1. **Send Options**

Control general settings for how you will send mail.

**Name that appears in outgoing mail:**

Choose the name that you want to appear on all outgoing mail, next to your email address.

**Note:** Even though you changed the name that appears on your outgoing messages, you did not change your Mullen Classic Autos login name. Continue to login to your Mullen Classic Autos account with your original login name.

**Reply-to for outgoing mail:**
Set the Reply-To address that will appear on outgoing mail. Allows you to received replies at another email account.

Save copy of outgoing mail in Sent folder
Check this box to save a copy of every outgoing mail in your Sent Folder.

Note: Saving a copy of your outgoing message allows you to reference then at a later time. These messages do count toward your storage so it is recommended that you periodically clear this folder.

When typing email addresses, auto-complete using address book entries
Check this box to have email auto-complete feature suggest matching email addresses from you address book when you are entering recipients for an email message.

Automatically Spell Check all messages
Check this box to have all email messages sent from the Webclient automatically spell-checked before sending.

Periodically auto-save a temporary copy of email in your Draft folder
Check this box to periodically auto-save a temporary copy of email you are composing in your Draft folder. If you subsequently lose power to your computer, close your browser, or cancel your email composition, you will still have a copy of your email in your Draft folder. When you send the message, it will be automatically removed from your Draft folder.

Note: If you are using a popup blocker, this feature may not work unless you allow popups from this site. This feature requires a constant connection to the Internet; if your Internet connection is lost, your browser may attempt to reconnect to the Internet.

Editor type
Choose between Rich or Plain editors for composing mail messages. The Rich editor allows rich formatting of text (bold, italics, underlines, fonts) and many options for layout of your message. The plain editor supports only simple text with no formatting.

8.1.3.2. Forward and Reply
Control special settings applicable when forwarding or replying to mail.

When replying to a message, quote original message with ‘>’
Check this box to quote the original portion of an email when replying to a message. If the Plain editor is used, each line will be prefixed with a ‘>’. If the Rich editor is used, the entire original text will be preceded with a vertical bar.

When forwarding, include the original message: ____
Choose whether to include the text of the original email message Inline (where you can edit the contents) or as an Attachment (where you cannot edit the contents) when forwarding an email.

Include default signature on replies and forwards
Check this box to include your default signature on replies and forwards. Your default signature will always be applied to new messages, but if this options it not checked, then your signature will be excluded from replies and forwards. You can manually apply signatures to any messages by using the Insert Signature button on the New Message page.

8.1.3.3. Address Book
Control settings for how the Address Book works with the Write Mail page.
Default address book lookup list:
Select the Address Book list you want as your default from the drop-down menu. This will be the first Address Book presented to you when you click on the button next to the To and Cc lines.

Enable Quick personal address book on new message compose page
Check this box if you would like to display the Quick Address Book on the Write Mail page. If not checked, your Address Book will display in a separate pop-up window when you click the button next to the To and Cc lines.

Save new addresses to my address book
Specify if you want to save new recipient email addresses to your address book.
Always - Always save all email recipient email addresses to your address book when sending an email message.
Never - Never save email recipient email addresses to your address book when sending an email message.
Prompt - Pop up a window asking which email recipient email addresses to save to your address book when sending an email message.

Note: If an email address that you are sending to already exists in your address book, it will not be added again with the Always setting selected, and it will not show up in the pop up window if you select Prompt as your setting.
8.1.4. Calendar

8.1.4.1. Free/Busy

Control access to your Free/Busy information.

Allow anyone in my company to view my free-busy time.
Choose this option to allow anyone in your company to view your free/busy time when displaying availability.

Allow anyone on Internet to view my free-busy time.

Allows you to grant access to anyone on the Internet to view your free-busy time. Some email clients, include Microsoft Outlook, allow people to specify the Free/Busy URL for their contacts. You can provide the following Free/Busy URL to your friends/co-workers so they can see your free-busy time: http://ui.test.usa.net/icalphp/vfreebusy.php?userid=postmaster@mullen.postoffice.net

8.1.4.2. Calendar Defaults

Control settings for viewing your calendar.

Default calendar view: ____

Select the default calendar view from the drop-down menu. Each time you enter your calendar, this is the initial view that will be presented.

Time precision: ____

Select time increments that will be included in the start and end times when creating a new calendar event.

Day/Week calendar hours: ____ - ____

Specify the start and end time for your normal calendar day. The Day and Week view of your calendar will display time slots for these hours. Events occurring outside these hours will show at the top of the Day and Week calendars.

First day of the week: ____

Specify the first day of the week as it should be displayed in a Week, Month, or Year calendar.

Show week numbers in month calendars

Check this box to display the week number in month and year views.

8.1.4.3. Reminders

Control how reminders are presented in the Webmail client.

Enable pop-up reminders

Check this box to display reminders before your scheduled calendar events or before your task due dates.

Default reminder time for new events: ____

Select the time from the drop-down menu to set the default amount of time prior to the start of a calendar event or a task due date that reminders should be displayed.

8.1.4.4. Import/Export

Import and export your calendar and tasks.

Import Calendar

Note: The file imported must be an iCal compliant file. Typically, iCal compliant files have a .ics file extension.

Category: If a category is selected or entered in this field, the new imported events will all be placed into that single category. Any categories on the imported events will be replaced by the selected or
entered category. If you wish to import the events without changing their categories, just select the empty category.

This can aid in sorting events when importing other calendars. Each imported calendar can be placed into its own category and then later select the option to filter on the calendar view to only show events in that category.

Calendar File to import: Enter the file to upload from your computer or click the browse button to open a file browser and select the file you wish to import.

Import: The import button begins the import process for the file selected.

Cancel: The cancel button cancels and closes the window.

Exporting calendar information from Microsoft Outlook: Microsoft Outlook does not provide a built in mechanism to export its calendar information to the iCal format. There are several third party tools to facilitate this export.

We recommend and have tested the following tool for exporting from Outlook:

Exporting from OS X iCal/Entourage: We support files that are exported on the mac directly from iCal. To do this, open the iCal program, select the calendar you wish to export in the Calendars window, select the menu File->Export and enter the file to export. On our site, select the Import button and that file you just saved.

To export Entourage calendar data, we recommend using iCal to import the data and then exporting that calendar to an .ics file that can be imported. To do this, open iCal select the menu File->import, in the pop-up window select Entourage. Once the Entourage import is complete, select the menu File->Export, enter the file to save the data to and then import that file with our import page.

Export Calendar

Export Tasks Only: Select this to only export tasks.

Export Calendar Only: Select this to only export calendar events.

Export both Calendar and Tasks: Select this to export both calendar events and tasks.

Export events/tasks that belong only to the selected categories: This will restrict the exported events/tasks that only have the selected categories. To export all events/tasks, select the 'All' category.

Export events/tasks that occur between this start and end date: Select a start and end date that exported events/tasks must fall between. Dates should be in mm/dd/yyyy format. To select a date, click on the calendar icon next to the text box, the date will be placed in the box.

Note: If there is a Start Date but no End Date, the events/tasks starting with the Start Date and ending with the last day of the year given in the Start Date will be exported.

If there is an End Date but no Start Date, the start date is assumed to be the date the export is started.

Export: The Export button will begin the exporting process. A window will prompt you for the file name to save the export.

Cancel: The Cancel button will cancel the export.

8.1.4.5. Categories [top]

Manage categories for calendar, tasks, and notes.

Manage Calendar/Tasks Custom Categories
Create and delete custom categories for calendar events and tasks. These custom categories, in addition to the standard categories, will then be available when creating new calendar events and tasks.

Manage Notes Custom Categories
Create and delete custom categories for notes. These custom categories, in addition to the standard categories, will then be available when creating new notes.

8.1.4.6. Select Layers [top]
Overlay my calendar with:
Check the boxes for any special calendars you would like to overlay onto your calendar, if any are available. These calendars will show up on your calendar in a different color.

8.2. Signatures
Click on the Options link on the left-hand navigation bar

Signature files can be created to save you time composing a message. Once created, a signature can be added to the end of outgoing mail. If a signature file is designated Default, it will automatically be added to the end of each outgoing message unless you specify otherwise.

8.2.1. New Signature
Click the New button (New) to create a new signature. You can create either a HTML or plain text signature
If you want to Edit a signature, you can either double click on the signature or use the right mouse menu to open it for edit.

8.2.2. Delete Signature

Click the Delete button to delete any signatures that you have selected.

8.2.3. Set Default Signature

If you want to set a signature as a default, you need to select the radio button in the far right column of the list.

If you want to include your default signature on message replies and forwards, you can choose the "Include default signature on replies and forwards" option on the "Write Mail" section of the Settings page. To access your settings, click on the Options icon.

8.3. Change Password

We recommend you change your password every 45 DAYS. You also should create a password that contains at least one number, one upper case character, and one special character (!,#,$, etc.).
Note: Passwords are case sensitive

Access Change Password

Click on the Options link on the left-hand navigation bar

Click on the Change Password link on the left-hand navigation bar

Type in your current password and then type in your new password two times, then click on the Save button.

Note: You may encounter security warnings when changing your password, because %EmailName% uses a secure connection for all password transactions. Please refer to Online Help section How to Disable Security Warnings on Your Browser for information on disabling these warnings.

8.4. Message Filters

8.4.1. Forwarding

Email forwarding allows you to forward emails to another email address.

To get to forwarding:

Go to your account settings by clicking the Options button in left-hand navigation bar.
Choose Message Filters from the navigation menu on the left.

Forwarding rules that are enabled are indicated by a ✓ image under 'Active' column. An inactive forwarding rule is available for use, but will not be used on incoming messages until activated.

If you wish to keep a copy of forwarded messages in your mailbox, enable the checkbox at the bottom of the window titled: Keep Local Copy of Forwarded Mail

8.4.1.1. Create a new forwarding rule

1) Click New to start creating a new rule
2) Choose the forward to address, this is the address the mail will be forwarded to

3) Choose when the forwarding rule will be used
   - **Always**: The forwarding rule will be used for all incoming messages
   - **When**: The forwarding rule will be used whenever an incoming message matched a given criteria
     - Subject, Sender, To, CC, or To and CC
       - Choose which part of the message heading to use in the filtering process
       - Choose which filtering function to use (Contains, Doesn't Contain, Is, Isn't, Starts With, Ends With, Is Empty)
       - In the third field, fill in your criteria
     - Body
       - Choose which filtering function to use (Contains, Doesn't Contain)
       - In the second field, fill in your criteria
     - Mail Type
       - Your choices for filtering by mail type are text, HTML and contains attachments. Select your preferred option from the pull-down menu.
       - **Note**: When you filter your mail by type, the entire message is used to determine filtering criteria, i.e., signatures and attachments are both considered part of the message. Therefore, an HTML message with an attached Word document will not sort as an HTML message.
     - Mail is received between
       - Select the time period you'd like filtered from these pull-down menus.
     - Mail Priority is
       - You can filter your mail by selecting whether the priority of the message is low, normal or high.
     - Mail Size is
       - You can filter your mail by selecting whether the size of the message is greater or less than a given size. All sizes are in Kilobytes
4) You have the option of adding additional criteria to the filter. To do so click the **More** button to choose the additional filtering criteria.

5) Save, When you are finished, click the Save icon ( ![Save icon](image) ) to save the rule.

**Note:** The forwarding rule will automatically be activated when saved.

### 8.4.1.2. Activate / Deactivate a forwarding rule

- Select the forwarding rule(s) from the list:
  - To enable the folder filter rule(s), click the **Activate** button ( ![Activate button](image) ) on the toolbar.
  - To disable the folder filter rule(s), click the **Disable** button ( ![Disable button](image) ) on the toolbar.

### 8.4.2. Notification

Notification filters allow you to forward emails to another email address without any attachments. This is ideal for mobile devices.

To get to notification filters:

Go to your account settings by clicking the Options button in left-hand navigation bar.

Choose Message Filters from the navigation menu on the left.
Go to the Notification tab.

Notification filter rules that are enabled are indicated by a ✓ image under Active column.

An inactive notification filter rule is available for use, but will not be used on incoming messages until activated.

8.4.2.1. Create a new notification filter

1) Click New to start creating a new filter rule

2) Choose the forward to address, this is the address the mail will be forwarded to

3) Choose when the notification filter rule will be used
   - Always: The notification filter rule will be used for all incoming messages
   - When: The notification filter rule will be used whenever an incoming message matched a given criteria
   - Subject, Sender, To, CC, or To and CC
     ○ Choose which part of the message heading to use in the filtering process
     ○ Choose which filtering function to use (Contains, Doesn't Contain, Is, Isn't, Starts With, Ends With, Is Empty)
     ○ In the third field, fill in your criteria
   - Body
     ○ Choose which filtering function to use (Contains, Doesn't Contain)
     ○ In the second field, fill in your criteria
   - Mail Type
Your choices for filtering by mail type are text, HTML and contains attachments. Select your preferred option from the pull-down menu. 

**Note:** When you filter your mail by type, the entire message is used to determine filtering criteria, i.e., signatures and attachments are both considered part of the message. Therefore, an HTML message with an attached Word document will not sort as an HTML message.

- Mail is received between
  - Select the time period you'd like filtered from these pull-down menus
- Mail Priority is
  - You can filter your mail by selecting whether the priority of the message is low, normal or high
- Mail Size is
  - You can filter your mail by selecting whether the size of the message is greater or less than a given size. All sizes are in Kilobytes

4) You have the option of adding additional criteria to the filter. To do so click More to choose the additional filtering criteria

5) Save, when you are finished, click the save icon ( ) to save the rule

**Note:** The notification filter rule will automatically be activated when saved

8.4.2.2. **Activate / deactivate a notification filter rule**

- Select the notification filter rule(s) from the list:
  - To enable the folder filter rule(s), click the **Activate** button ( ) on the toolbar
  - To disable the folder filter rule(s), click the **Disable** button ( ) on the toolbar

8.4.3. **White List**

To configure your personal white list filters, please follow these steps:

1) Determine what you would like done to the messages that match one of your filters. This generally fits into two categories, **Override** or **Exclusive**. Override allows you to override your spam filters, including system spam filtering, and is handy when you have mail that is occasionally incorrectly marked as spam by the system spam filters. Exclusive allows you to limit the mail you
receive to only those messages that match your White List; all other mail messages will either be considered Junk Mail or automatically deleted. If you choose Exclusive, you will need to specify whether to keep the mail as Junk Mail or to delete the mail. If you choose to delete all mail that does not match your White List, this mail cannot be recovered later.

Your options are:

- **Override** - matching messages will not be considered spam
- **Exclusive** - only messages matching White List will be accepted
  - Store in Junk Mail all messages not matched by White List
  - Delete all messages not matched by White List

**Note:** This setting will apply to all personal white list filters that you set up.

2) You also have the option of including all of your email addresses from your Contacts as part of your white list filters. If you choose this option, the sender of emails to you will be checked against your Contact list.

- Go to your account settings by clicking the **Options button** in left-hand navigation bar
- Choose Message Filters from the navigation menu on the left
- Go to the White List tab
- Click New to create a new personal white list filter
3) Designate when the personal white list filter will be used. You have the following criteria options:

1) Subject, Sender, To, CC, or To and CC
   o Choose which part of the message heading to use in the filtering process
   o Choose which filtering function to use (Contains, Doesn't Contain, Is, Isn't, Starts With, Ends With, Is Empty)
   o In the third field, fill in your criteria

2) Body
   o Choose which filtering function to use (Contains, Doesn't Contain)
   o In the second field, fill in your criteria

3) Mail Type
   o Your choices for filtering by mail type are text, HTML and contains attachments. Select your preferred option from the pull-down menu. Note: When you filter your mail by type, the entire message is used to determine filtering criteria, i.e., signatures and attachments are both considered part of the message. Therefore, an HTML message with an attached Word document will not sort as an HTML message

4) Mail is received between
   o Select the time period you'd like filtered from these pull-down menus

5) Mail Priority is
   o You can filter your mail by selecting whether the priority of the message is low, normal or high

6) Mail Size is
You can filter your mail by selecting whether the size of the message is greater or less than a given size. All sizes are in Kilobytes. You have the option of creating additional criteria on the filter. To do so click **More** to choose the additional filtering criteria.

7) Click the save icon in the top left
8.4.4. Junk Mail Filters

8.4.4.1. Enhanced Spam Filtering

Enhanced spam filtering provides advanced analysis of email content to determine the likelihood that messages are spam. Using tools by Cloudmark and Brightmail, we rate the likelihood that a message is spam, from a low-end of 0 (not spam) to a high-end of 5 (extremely likely spam).

Use the Enhanced Spam Filtering Settings section to configure default actions for your messages based on their spam classification level.

8) You can specify which, if any, mail messages should be deleted automatically based on the spam score

9) You can also specify which, if any, mail messages should be moved to the Junk Mail folder based on the spam score. If you choose to delete some mail and move some mail to the Junk Mail folder, the spam score chosen for Delete must be higher than the spam score chosen for Move to Junk Mail.
8.4.4.2. Personal Spam Filtering

Spam filters are used for handling incoming spam. Spam can be dealt with by either deleting matching emails, or filing them to your junk mail folder.

To configure your personal spam filters, please follow these steps:

1) Go to your account settings by clicking the Options button in left-hand navigation bar

10) Choose Message Filters from the navigation menu on the left

11) Go to the Junk Mail tab
2) Select the action you wish to perform with mail identified by your personal spam filters in the Person Spam Filter Settings section,

12) **Delete messages** identified as spam

13) or **Move messages** identified as spam to my Junk Mail Folder

**Note:** This setting will apply to all personal spam filters that you set up

---

8.4.4.3. **New Personal Junk Mail Filter**

1) Click the **New** button ( ) to create a new personal junk mail filter

2) Designate when the personal white list filter will be used. You have the following criteria options:

- Subject, Sender, To, CC, or To and CC
  - Choose which part of the message heading to use in the filtering process.
  - Choose which filtering function to use (Contains, Doesn't Contain, Is, Isn't, Starts With, Ends With, Is Empty).
  - In the third field, fill in your criteria.
• **Body**
  - Choose which filtering function to use (Contains, Doesn't Contain).
  - In the second field, fill in your criteria.

• **Mail Type**
  - Your choices for filtering by mail type are text, HTML and contains attachments. Select your preferred option from the pull-down menu.
    
    **Note:** When you filter your mail by type, the entire message is used to determine filtering criteria, i.e., signatures and attachments are both considered part of the message. Therefore, an HTML message with an attached Word document will not sort as an HTML message.

• **Mail is received between**
  - Select the time period you'd like filtered from these pull-down menus.

• **Mail Priority is**
  - You can filter your mail by selecting whether the priority of the message is low, normal or high.

• **Mail Size is**
  - You can filter your mail by selecting whether the size of the message is greater or less than a given size. All sizes are in Kilobytes.

You have the option of adding additional criteria to the filter. To do so click **More** to choose the additional filtering criteria.
3) Click the **Save** button ( ) in the top left to save the filter

8.4.5. **Additional Considerations**

1) **Do Not Reply to Spam**: The worst thing you can do with spam messages is reply or "unsubscribe" to them. This is an old trick of the trade for spammers. By replying or "unsubscribing" to junk mail, you are confirming that you check your email, and then spammers identify your account as an "active" account and will continue to send you spam. The best thing to do is delete the message without opening it.

2) **Be Careful About Your Email Address**: When surfing online, be careful what websites you give your email address. This is the most common way spammers find your email address. A lot of times when registering with a site, you will want to be careful of what that site does with your information. A good idea is to check out their privacy policy to see what their standard is for handling customer information. You will want to be sure that they do not give it or sell it to third party vendors (a.k.a. spammers). If a website does not have a privacy policy, DO NOT give them any of your personal information, as there is no guarantee that they will not use it or sell it to other companies. An idea to consider is to use an alternate email address when registering with...
websites. This email address could be one from any free email provider (i.e., Hotmail, Yahoo!, etc.). This email address' sole purpose is to be used for registering or signing up with websites. That way you avoid handing out your personal or business email address and if junk mail is sent from the site you registered with, it will go to an email address that is not important to you.

3) **Email Addresses on Websites:** Another common way spammers can get your email address is if you have it posted on a website. Spammers search the web collecting email addresses from any site they come across. In the real estate industry, it is necessary to have a website and allow your customers to get in touch with you electronically. This may make you more susceptible to spam if your email address is out in plain view on your website. An option you may want to consider is that instead of having your email address out on your web page have an electronic form that customers can fill out and then it will be submitted directly to your email address. This has the same effect as posting your email address on your website, but gives added security to your email identity. These forms are common online and fairly simple to setup.

### 8.5. Vacation Reply

#### 8.5.1. Overview

The Vacation Reply feature allows you to automatically send a reply in response to all incoming mail for a specified time period.

1) To access the Vacation Reply settings go to your account settings by clicking the Options button in left-hand navigation bar.

![Options Button](image)

2) Choose Vacation Reply from the navigation menu on the left. From this menu you will be able to create a Vacation Reply. **Note:** You may have only one Vacation Reply created at a time.

![Options Menu](image)

#### 8.5.2. Create a Vacation Reply

1) To create a new Vacation Reply message, click the New button ( ).
2) First, select the time period during which your Vacation Reply message will automatically be sent out in response to all incoming mail. Choose the appropriate start and end dates by selecting the appropriate month, day, year, and hour, for both the Start Date and the Ending Date.

3) Next, compose the content of your Vacation Reply message in the message body area.

4) If you’d like to attach a Signature to your Vacation Reply message, click the **Signature** button and select the appropriate signature.

5) You can preview and check the spelling of your Vacation Reply message by clicking the **Preview** and **Check Spelling** buttons.
6) Click the **Save** button ( ) when you have finished setting up your Vacation Reply message. Your Vacation Reply message will be listed on the main Vacation Reply page, and will automatically be activated. To activate or disable it, select the check box next to the vacation reply and then click either the **Activate** ( ) or **Disable** button ( ) accordingly.

8.5.3. **Edit or Delete a Vacation Reply**

1) **Edit**: double click the Vacation Reply to open it up and edit the message

2) **Delete**: Single click the Vacation Reply to highlight it, click the Delete button ( ) to delete it

**Note**: You must delete the current Vacation Reply setting before you can create a new one. When there is an existing Vacation Reply setting, you will not have the option of the **New** button.

8.6. **Message History**

**Message History** allows you to view an itemized listing of all incoming and outgoing email.

To view your **Message History**, go to **Options → Message History**

This will display a list of emails that have been sent and received by your account and the actions taken on them.
To view information about a particular message, **Double Click** on the mail message in the message list. The following information about your message will be displayed:

- The **Message ID** (also called the Internal Tracking Number)
- The date and time that the message was received in your account
- The sender of the message. (From)
- The recipient of the message
- The subject of the message
- The size of the message
- The action taken on the message (each action will have a separate Message History detail). (Disposition)

To read a message from the Message History File

- When viewing the information about your message, click the **Subject link** to read the actual text of the message

**Note**: You can only access those messages that are stored in one of your Folders

- In order to read your **Outgoing Mail**, the "**Save in Sent Folder**" option must be selected for your outgoing mail. The "**Save in Sent Folder**" option is available in **Options ➔ Settings**, under the **Write Mail** tab
• When a Message History entry turns **8 DAYS OLD**, it will automatically be deleted from the Message History File

8.7. **Restore Mail**

You have the option to self-restore messages that were emptied from your "Trash Folder". This option is available for up to **14 DAYS** after the messages were moved to the "Trash Folder". This feature also allows you to restore deleted contacts, events, notes and tasks. Note that messages, contacts, events, notes and tasks are permanently deleted **14 DAYS** after they were moved to the Trash Folder and can no longer be recovered.

The default setting in your account is for the self-restore feature to be active. You can disable this feature under the **Options ➔ Settings ➔ General** tab.

Select the check box next to "**Do not allow messages to be restored after emptying Trash**" and click the Save icon (Save) to disable the restore messages feature. If you disable this feature, however, there is no ability to recover email and other items that could otherwise be restored.

To view a list of deleted messages that can be restored go to **Options ➔ Restore Mail**

• Select the messages you wish to restore to your "Trash Folder"
• Click on the Restore icon ( )

• Or, if there are less than 3000 messages available to be restored, you can click the Restore All icon ( ) and all the messages available for restore will be moved to the trash folder

• Also available on this page is the ability to permanently delete messages so that they cannot be restored. Individual messages can be selected and then permanently deleted with the Delete icon ( )

• Or, all messages in the restore list can be permanently deleted with the Delete All icon ( )

8.8. Access History

This feature will show you all of the access attempts to your account for the past seven days

To view your history, follow these steps:

Click on Options on the Navigation Bar on the left side of your screen

Click on the Access History option

This page will show successful and unsuccessful attempts for the following different access methods:

<table>
<thead>
<tr>
<th>Access History</th>
<th>Last Access Date (MST)</th>
<th>Access Type</th>
<th>IP Address</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/11/09 11:12 AM</td>
<td>Web</td>
<td>165.212.225.6</td>
<td>Success</td>
<td></td>
</tr>
<tr>
<td>12/11/09 11:05 AM</td>
<td>Web</td>
<td>204.68.20.89</td>
<td>Success</td>
<td></td>
</tr>
<tr>
<td>12/11/09 09:20 AM</td>
<td>Web</td>
<td>204.68.20.69</td>
<td>Success</td>
<td></td>
</tr>
<tr>
<td>12/10/09 03:26 PM</td>
<td>Web</td>
<td>204.68.20.89</td>
<td>Success</td>
<td></td>
</tr>
<tr>
<td>12/10/09 03:17 PM</td>
<td>Web</td>
<td>204.68.20.89</td>
<td>Success</td>
<td></td>
</tr>
</tbody>
</table>
• **Web** - Attempts to access through the Webmail client, the mobile phone web client, or a Wireless Sync SyncML client
• **POP** - Attempts to download mail with a POP mail client
• **IMAP** - Attempts to download mail with an IMAP mail client
• **ASMTPL** - Attempts to send mail with an Authenticated SMTP client

The page will show the number of successful and/or unsuccessful attempts made each day for each of the access methods from any IP address.

## 9. Wireless Access

### 9.1. POP3 Settings

To configure your POP (Post Office Protocol) compliant email software to retrieve email from your eMail@century21.com account, please follow these steps:

1. Go to the set up section of your email software
2. Set the protocol (or mail server type) to POP
3. Change the Incoming Mail (POP) information to: **pop3.postoffice.net**
4. Change your POP User Name or Account to your new User Name, including the domain name, using the following format:
   
   login name//domain name

   **john.smith//century21.com**

5. Change your "Reply To" address to your new **eMail@century21.com** address (e.g.,
   **john.smith@century21.com**).

6. For your Outgoing Mail (SMTP) information, you may use our SMTP server address,
   **smtp.postoffice.net**, or your ISP's Outgoing Mail server address, which you must obtain from
   your ISP. **Note:** If using our SMTP server, you must use authenticated SMTP. **Note:** If using our
   SMTP server, you must use authenticated SMTP. This means you will need to select the option
   that says "My server requires authentication".

7. You may have the option of leaving a copy of your mail on our mail server. Please note, if you
   select this option and POP your mail, we will send you email notifications if you approach or
   exceed your storage quota. Accounts which surpass storage quota will not be eligible to receive
   incoming mail. CENTURY21 suggests deleting mail stored at your CENTURY21 account on a
   routine basis.

All of your outgoing (sent) email will now contain your new CENTURY21 address in the "Reply To" line
of the header. All "replies" to your email will now be sent to your CENTURY21 email address.

**Notes:**

- Your password for POP mail is the same as your eMail@century21.com password.